5 Verify Successful DVD Installation

5.1 Verify Flash and Xine Install

1. Login as user fxa.

2. Verify the Flash plugin installation by viewing the WES8.3 Flash verification
presentation in a web browser:

e.g. Firefox
file:///awips/Ttxa/DRT/wessl/source/articulate/flash_verificat

1on/player._html

Note: Following a successful installation, there should be a “yes” in the browser
under the “Enabled” column found by clicking “Help” and then “About Plug-
ins”. If the presentation fails to load, then review the manual Flash plugin
installation in Section 22.

3. Verify the Xine installation by viewing an mpeg:

e.g. xine Zawips/ftxa/DRT/wessl/source/video/9jun05.mpg

Note: If Xine fails to load, then review the manual Xine installation in Section
23.

5.2 Install WES Test Case

1. In order to verify a successful installation, install the test case in /dataZawips from
the WESS8.3 install DVD. After successfully viewing the test case data in Section 5.3,
move on to Section 5.4 to run a simulation. If you experience problems viewing the
test case, contact WES support before attempting to run a simulation.

Note: You will eventually need to create new localizations for all your old cases
(see Sections 7 - 9) before you can fully display them in D2D with the OB8.3

AWIPS in WESS.3.
Note: All FFMP data need to be recreated with WES8.3. The format of the

FFMP data changed again in OB8.3
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2. As user fxa, load and mount the Weather Event Simulator 8.3 install DVD:
e.g. mount /media/cdrecorder if the DVD doesn't automatically mount

3. To install the test case, change directory to the DVD device and run the
wes83_testcase_install program:

e.g. cd /media/cdrecorder

e.g. -/wes83 testcase_install

Note: If you have previously installed a WES test case, you may see the
message “A case already exists in /data/awips/2006Aug24test”. Remove or
move that case as directed.

4. After the case has been installed, some archived warning text products included in
the test case will need to be inserted into a new Postgres database while the case is
in “original format”:

- Run start_simulator
- Click the “Tools” button
- Click the “Write Archived Text to Database” button

- Use the Select button to choose the 2006Aug24test case for FXA_DATA and ABR
as FXA_LOCAL_SITE

- Click “OK”
- The simulator will display “Write to postgres database complete” when finished

- Click “Exit”

Note: This tool will write all text products stored in
<data_case>/archived_text/<awips_pil>/YYYYMMDD_HHmmss to a
postgres database stored in <data_case>/pgdata. For more information on
archiving text and writing the text to a Postgres database, see Section 11.

5.3 Verify the Test Case in Enhanced Case Review Mode

1. Start D2D on the 2006Aug24test test case by typing enhanced_case_review at
a shell prompt, hitting return, and:
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- Select 2006Aug24test as the FXA_DATA and ABR as the FXA_LOCAL_SITE
- Select the “Start AWIPS Text Workstation Control” checkbox
- Click the “OK” button

- Click “Start” on the D2D launcher

Note: The enhanced_case_review application starts up D2D and a few other
AWIPS processes for text database access for FFMP and SCAN to work fully in
static case review mode outside of a simulation. The enhanced_case_review
script works with both “original” or “DRT” format cases, though the program
cannot be run alongside the simulator (start_simulator) due to interference
with the AWIPS processes. The Zawips/Ttxa/DRT/start_awips program
starts D2D during a simulation. For more on enhanced_case_review see
Section 17.

Note: WarnGen, GFE and AvnFPS applications do not work in
enhanced_case_review. Run a simulation to use these applications.

2. Ensure the Guardian application is running correctly and generate a test pop-up:

- After D2D starts up, there should be a bar below D2D containing several icons and
two status bars

- Click the Guardian icon @

- The Guardian Configuration GUI should appear

- Close the Guardian Configuration GUI by pressing the “x” or the “Close” button
- In D2D, select CONUS scale and load 13u under the Satellite menu

- Ared Guardian pop-up should appear with a “No Data Inventory” message

- Close the pop-up by pressing the “Close” button or “Acknowledge Last”

3. Ensure the radar data for the first test case were loaded correctly by viewing the All
Tilts kabr Z/SRM8 radar data in D2D:

- Select 64 in the Frames menu
- Select WFO as the scale

- Under the kabr menu, select All Tilts Z/SRM8
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Step through a time loop of a single elevation angle by using the left/right arrow
keys. Step through a volume scan vertically at a fixed time by using the up/down
arrow keys.

Note: The data in this case contains a couple of hours of radar and satellite
data, and some limited Grid and point data.

Under the Volume menu find the Std Env Data Package section, and select LAPS.
As you sample the radar data in time and space in D2D with the left mouse button,
the environmental information (e.g. Wind, RH, T) should show up in the cursor
readout. If you right click on the Temperature text in the legend and select a
Density of 1, you should see isotherms interpolated to the radar tilts.

Under the Volume menu select Popup SkewT, and then right click on the main
D2D pane and select Laps under the Sample Cloud Heights/Radar Skew T
pullout menu. As you sample the radar data in time and space using the left mouse
button, the popup SkewT should update with the height of the radar observation.

Clear the D2D pane and close the Popup SkewT window

. Use D2D to display polygons contained in the archived text data. This step assumes
the archived warning text products in the 2006Aug24test case were written to the
Postgres database (step 4 of Section 5.2)

Clear the pane, select 12 in the Frames menu, select WFO scale, load a 0.5
Z/SRM8 from the kabr menu, and load Local CWA Warnings from under the Obs
menu

A warning polygon should display when stepping through the loop
Clear the pane

In the Text Workstation window click on “Text 1” on the Text Workstation Control
(outside D2D), enter FSDTORABR in AFOS Cmd and hit return

The text of an archived warning should appear
. Display the FFMP data for kabr while in enhanced case review.
In D2D, choose WFO scale and clear the pane

Under the SCAN menu in D2D, navigate to the FFMP and kabr submenus, and
select FFMP kabr Display

Select ABR under the CWA menu. Then click “Refresh D2D”
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A colored county map should be visible in D2D, and the table contents should
change.

In the FFMP table select All & Only Small Basins from the Layer button, and
select ratio from the D2D button. Then click Refresh D2D. The D2D should update
with the ratio product (see text legend in upper left part of D2D) drawn for the basin
scale.

While in the basin Layer, left mouse click on any cell under the NAME column to
zoom in on a basin. Then right click on the same cell to generate a time series for
that basin.

Clear the D2D pane.

Note: FFMP changed significantly in OB8.3 and WESS8.3. See Section 12 for
everything you need to know about FFMP in WES.

. Display the SCAN storm cells table for kabr:
In D2D, choose WFO scale and clear the pane
Select 12 in the Frames menu

Under the SCAN menu in D2D select Storm Cells / Site Storm Threat under the
SCAN:kabr submenu. The KABR Cell Table should launch

To remove the SCAN table, hit the Clear button in D2D
. Display the SCAN DMD for kabr:

Under the SCAN menu in D2D select Storm DMD Icons & Table under the
SCAN:kabr submenu

Right click on “lIVr” for the DMD identifier 342 to launch a time-height display of
DMD data

Toggle the graphical display overlays by clicking on the “Diam Overlay” along with
“Legend”, “Elev Angles”, and “Vol Scan Poles”

Click “Close”

In the DMD Table, select “Link to Frame” and navigate back and forth through time
using the left and right arrow keys to view the DMD icons

Left click and hover over a meso circle in D2D for a cursor readout of the data

To unload the SCAN DMD table and D2D icon display, click the Clear button in D2D
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Under the kabr menu, select kabr Graphics, and Digital Mesocyclone (DMD) to
display the DMD data using the D2D DMD display option.

Left click and hover over a meso circle in D2D for a cursor readout of the data.

Navigate back and forth through time using the arrow keys to view the DMD icons

Note: For information on enabling SCAN functionality for your own case data
please refer to Section 13.

Clear the main pane, and while on WFO scale select All Tilts Z/SRM8 under the
kabr menu. Step through the data, and zoom in on a storm to load FSI on (next
step).

Note: You should always load FSI on a radar product to ensure FSI will launch
correctly.

10.Under the Tools menu, select 4-D Storm Investigator (FSI)

Right click anywhere on the main pane and then click “Continue” in the FSI Time
Entry Window (As explained below, this window may take a few seconds to appear).
The FSI time entry window will come up in case review and contain a useful default
based on the time entered in D2D or the beginning/end time of the available data.
You can use this entry to specify the time to view using FSI.

Note: If you have more than one dedicated radar in your case, FSI will prompt
you to select which radar to load. There is only one dedicated radar in the WES
test case.

Wait while WES creates an inventory of files and an FSI linear buffer. The first time
FSl is launched on a radar in a case, this process can take fifteen seconds to one
minute. After that, FSI will load much more quickly each time it is launched.

Once FSl is loaded, navigate through time by using the arrow keys on the numeric
keypad (make sure Num Lock is turned on). WES creates a four hour FSI linear
buffer while in case review (for cases with greater than four hours of data).

Turn cursor sampling on by clicking on the magnifying glass button in FSI. Move
your mouse over the data to sample data in FSI.

Toggle to velocity using the “.” key on the numeric keypad. Recenter on some data
at far range from the radar by left mouse clicking on the data in the upper left PPI
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window and dragging it to the center of the PPI window. Roam over the velocity
data, and note that the default sampling mode is not exact.

- Configure the “triangles” display option to make exact cursor sampling using the
following instructions:

o click on the wrench/screwdriver button in FSI,

o click on the Advanced Settings disclosure triangle, select the OpenGL
option, and select “Use Triangles over Textures (Readout accuracy vs
speed)”,

o under the “File” menu select “Save Settings” and “Exit”. Now relaunch
FSI in the same way as before and zoom in on velocity data to verify the
cursor readout is exact.

Note: You have to save and exit for the triangles option to take effect. Also note
that making cursor readout exact can decrease performance, particularly when
looking at Super Resolution Data (not included in this test case).

- Move the cross section bar in the PPI (upper-left pane) by clicking the left mouse
button on the middle circle and moving the mouse. The vertical cross section
should dynamically update.

- Click the “i” key on the keyboard to toggle interpolation on and off.

- Click the 1 through 4 buttons on the upper left part of the keyboard to toggle
between Z, V, SRM, and SW.

- Move the height of the CAPPI (upper-right pane) by selecting the blue bar on the
right, and dragging it up and down. Note the data down samples to degraded
resolution when it is moved.

- Pan the display in the “3D Flier” window (lower-right pane) holding down the left
mouse button and dragging the mouse toward and away from you.

- Pitch and yaw the display in the “3D Flier” window (lower-right pane) by holding the
shift key with one hand, holding down the left mouse button, and moving the mouse.

- Zoom in the “3D Flier” window by holding the middle mouse button and dragging the
mouse toward and away from you.

- Exit FSI under the File menu

11. Shutdown D2D and the Text Workstation Control by selecting Exit under the File
menus of D2D and the Text Workstation Control.
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5.4 Verify AWIPS/WES in Simulation Mode

If you had problems viewing the test case in Section 5.3, please contact WES support
(wes@infolist.nws.noaa.gov) before attempting to run a simulation in this section. In this
section you will run a simulation using the test case. A simulation start time for this case
(2205 UTC on August 24, 2006) has been set as the default along with a WESSL file
setting and an ffmp tar file setting.

Note: If you have not run a simulation before, click on the “Help” menu (upper
right portion of the WES main window) and “Instructions” submenu, and follow
the instructions under “Convert Case to DRT Format” and “Run Simulation”.

1. Runstart_simulator

2. Convert the 2006Aug24test case to “DRT format”:

e.g. click the “Tools” button, click the “Convert Case Data to DRT Format” button,
select 2006Aug24test as the FXA_DATA case location, click “OK” and click
“Convert”

Conversion to DRT format can take several minutes to complete
3. Load the wes83 test _case ABR macro to run a simulation:

e.g. click the “Run Simulation” button and the “OK” button in the D2D warning
popup

e.g. click the “Load Saved Settings” button, and select wes83_test_case_ABR,
then click the “OK” button in the “Load” window followed by the “OK” button in the
Simulation Entry window

4. Click the “Run Simulation” button when the Entry Verification window appears.

5. When the simulator prompts you to restart any D2D sessions, run start_awips in
a new terminal. In the start_awips GUI select 2006Aug24test as the case, and click
the “Start AWIPS Text Workstation Control” checkbox.

6. Ensure the Guardian application is running correctly and generate a test pop-up:

- After D2D starts up, there should be a horizontal toolbar below the D2D window
containing several icons and two status bars

- Click the Guardian icon '@

- The Guardian Configuration GUI should appear
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- Close the Guardian Configuration GUI by pressing “x “or the “Close” button
- Select CONUS scale and load 13u under the Satellite menu.

- Ared Guardian pop-up should appear with a “No Data Inventory” message
- Close the pop-up by pressing the “Close” button or “Acknowledge Last”

7. Select WFO scale, 64 frames, and All Tilts Z/SRM8 from the kabr menu, and verify
the display updates with new data (usually once per minute).

Note: Every 15 seconds the main WES window updates with data being
processed, D2D displays should refresh shortly after the WES window lists the
processed files.

- Toggle to the SRM 8 product by selecting the “.” key on the numeric keypad.
- Under the Tools menu load Radar Display Controls
- Enter 280 degrees at 26 kts as the SRM Custom Storm Motion

- Trigger the display to update the new storm motion in the upper left of the main
pane by zooming in on the storm or moving the center of the display

8. Verify that WESSL pop-up windows appear. Once the WESSL pop-ups appear, you
can use the forward and backward buttons on the WESSL Station Log window to
review previous WESSL windows.

9. Clear the main pane, and while on WFO scale select All Tilts Z/SRM8 under the
kabr menu

10.Under the Tools menu, select 4-D Storm Investigator (FSI)
- Right click on a storm anywhere on the main pane

- Wait while FSI launches (it can take 5-10 seconds)

Note: During a simulation, the FSI time entry window does not appear. The FSI
time entry window is only for case review.

- Once FSl is loaded, navigate through time by using the arrow keys on the number
pad (make sure Num Lock is turned on). At the start of the simulation a two hour FSI
linear buffer is created to allow viewing of the latest two hours of radar data in FSI,
just like in a real time AWIPS.
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- While viewing the reflectivity product, click on the magnifying glass button to turn
on cursor sampling. Move the pointer over the data to verify sampling is working.

- Watch the product legend in the upper right part of the FSI display for when the tilts
are processed in FSI each minute.

- Exit FSI under the File menu

11.Test create a warning with WarnGen in D2D:

- Clear the D2D pane and select a WFO scale map

- With no product loaded click on the “WarnGen” button in the upper right part of D2D
- Select Tornado for Product Type in the WarnGen popup window

- Move the "Drag me to storm" icon to somewhere in the center of the map

- Click on the "Create Text" button on WarnGen popup window

- A text window should appear if the text monitor was started with D2D

- Click "Enter" to modify the warning

- Replace the line at the bottom containing “I**NAME/INITIALS**!” with your initials
- Click the "Send" button

- In a new pane on WFO scale load Local CWA Warnings from the Obs menu in
D2D

Note: If you load a new warning polygon over old product data you need to wait
about a minute for the polygon to be displayed or you may need to select
Forced for the time matching in the upper left part of D2D for the time matching
to work.

12. After verifying the install was successful, shutdown D2D and the Text Workstation
Control by selecting Exit under the File menus of D2D and the Text Workstation
Control. Stop the simulation by pressing the Stop Simulation button on the WES
control interface. Exit the simulator by clicking the Exit button on the main WES
interface.

13.You may consider putting icons on the desktop to start the start_simulator,
start_awips, and enhanced_case_review scripts. For start_simulator,
you need to select “Run in Terminal” for the desktop icon to prevent spontaneous
logouts when exiting the simulator.
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Note: FFMP, SCAN and DMD data are unique for each simulation. These
products are created every volume scan from their input files. Thus, these input
files must exist in the case for FFMP, SCAN and DMD to work successfully
during a simulation.

14.Verify the test warning text was saved. In the process of creating warnings, AWIPS
writes the text to a file in the <data_case>/textWSwork/$DISPLAY directory
where $DISPLAY is the DISPLAY variable that identifies the monitor where Text
Workstation Control Monitor runs.

After each simulation, WES copies the textWSwork directory is copied to the
<data_case>/saved_textWSwork/textWSwork.<date> directory (where
<date> is the current actual time when the simulation ends.

e.g. cd /dataZawips/2006Aug24test/saved textWSwork

e.g. Is (to look for the latest directory)

e.g. cd textWSwork.200712162234 (for example)

e.g. Il —R * (to look for a display directory like :0.1 with a KABR warning file)
e.g. cd :-0.0/saved (for example)

e.g. more KABRTORABR.wan20060824 220726 (for example)

5.5 Verify GFE/WES in Simulation Mode

1. Run a simulation using start_simulator, with the
wes83_GFE_test _case ABR macro. This enables GFE functionality with
the2006Aug24test data (note the “GFE” in the macro name):

e.g. run start_simulator

e.g. click the “Run Simulation” button and the “OK” button in the D2D warning
popup

e.g. click the “Load Saved Settings” button, and select
wes83 GFE_test case ABR, then click the “OK” button in the Load window
followed by the “OK” button in the Simulation Entry window.

e.g. click the “Run Simulation” button
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Note: When a GFE Directory is selected in the simulation entry window, the
IFPServer is launched with other AWIPS decoders. The IFPServer is required
for GFE to work and can only be invoked during a simulation. When the
simulation begins, GFE is purged of any new data files. The IFPServer takes a
minute or two to start up, and requires a significant amount of resources to
initialize, so your machine may temporarily slowed down.

2. After starting a simulation, start GFE in “PRACTICE” mode by running start_GFE
in a new terminal.

Note: The “start_GFE” program, which is in your $PATH, launches GFE in
practice mode (see Zawips/Txa/DRT/start_GFE for more information). GFE
only launches after the IFPServer is operational during a WES simulation. Once
a simulation has been detected with a valid GFE directory, GFE may take a
minute or two to start up as it waits for the IFPServer to initialize.

3. Set-up GFE and begin:

- When the GFE Startup popup appears, select fxa as the User, gfeConfig as the
Config, and practice as the Mode, then click the “Start” button.

4. Populate your grids with the RUCB80:
- Under the Populate menu, select Copy All Grids From...
- Select RUCB80 2421 (ABR), and click the “OK” button.

- Switch to the vertical mode by selecting the top left button with the vertical line in the

box !I.
- Click on “T SFC” grid, and step through the images using the right arrow key
5. Test creating warning hazard grids:
- Under the Hazards menu, select MakeHazard

- Click and drag to select some counties in the county display and “IP.W — SLEET
WARNING” as the hazard

- Adjust the Hazard End Time to 12z on Aug 25, and click the “Run” button
- Click the “Clear All” button to clear the counties
- Select some other counties, and “IS.W — ICE STORM WARNING" as the hazard

- Adjust the Hazard End Time to 12z on Aug 25, and click the “Run/Dismiss” button
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- Under the Hazards menu, select MergeHazards
- Drag the vertical scroll bar down, select the Hazards SFC grid, and use the right
arrow key to view the hazards

- Save the forecast grids by clicking on the diskette button EI on the GFE
interface, followed by clicking on the “Save Weather Element(s)” button

Note: Forecast grids must be saved for GFE to generate the hazard text

6. Test creating the warning hazard text:

- Under the Products menu, select Formatter Launcher

- Under the next Products menu on the GUI that appears, select the Hazard pullout
menu, and the Hazard_ WSW (Winter Wx Product)

- Click on the “Run Formatter” gear box button ﬁl , and your warning text will
appear after a few seconds

- Modify or delete all the “|*” placeholders in the warning text

- Click on the “Transmit” button, and then the “Simulated Transmit” button

Note: The GFE product text is saved in the <data_case>/GFESuite-
case/<your_case_GFE_DIR>/products/PRACTICE directory. When the
simulation exits, WES copies the text directory to
<data_case>/saved_GFE_PRACTICE directory, with a time stamp based on
the actual time.

7. Exit out of GFE, and shut down the simulation.

5.6 Test Creating New GFE Grids

Background: A tool exists within WES to use the AWIPS IFPServer to create a set of
GFE default grids for incorporation into a WES simulation. Any such GFE datasets are
selected from the WES main simulation entry window. When a GFE dataset is selected,
WES starts the IFPServer in a simulation to allow the GFE to function. For more
information on GFE in WES, please see Section 18.

1. Under the “Tools” button in start_simulator, click “Create GFE Dataset”.
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2. Select 2006Aug24test as the FXA_DATA, ABR as the FXA_LOCAL_SITE, and
200608241505 (1505z on Aug 24, 2006) as the time to create the grids for, and click
“OK”.

Note: The IFPServer usually takes a couple of minutes to start up before it
launches the ifplnit process to create the actual grids. If ifpInit fails to launch, the
WES times out after five minutes. Once the ifplnit starts, the WES Log window
will read “Monitoring ifpInit for completion”, and the status bar will read
“Creating Data”.

3. Wait for ifplnit to complete. For this small case, ifpInit will only take a minute or two,
since it only creates a RUCS80 set of grids. Normally it can take an hour or two for a
full case. You may also choose to monitor the processes by running a top
command in another shell window. The WES log window will read “Finished
creating GFE data” when complete.

4. Once the GFE data is created, you can run a simulation to view the grids with GFE
and create warnings.

- After selecting the “Run Simulation” button in start_simulator, click “OK” on
the first popup, and then select the simulation details, including using the “Select”
button next to GFE Directory to select the GFE data just created (note the 1505
UTC simulation start time should match the GFE Directory data time)

- Click the “OK” button, and then the “Run Simulation” button on the popup Entry
Verification Window to start the simulation

- In a shell window, type start_GFE, and follow Section 5.5 Steps 3-7 using the 15Z
RUC80. When done, exit the Simulator by pressing the Exit button.

5.7 Verify AvnFPS in Simulation Mode

1. Runstart _simulator

Note: Like GFE, AvnFPS is only available during a simulation.

2. Load the wes83 AvnFPS test case ABR macro to run a simulation:

e.g. click the “Run Simulation” button and the “OK” button in the D2D warning
popup

6/26/2008 24



e.g. click the “Load Saved Settings” button, and select
wes83 AvnFPS test case ABR, then click the “OK” button in the Load window
followed by the “OK” button in the Simulation Entry window

Note: Notice the entry section labeled “TAFs Directory”. This entry specifies a
directory containing the TAFs used to initialize the simulation. AvnFPS
processes only run in simulation mode and only when the TAF directory is
specified.

3. Click the “Run Simulation” button when the Entry Verification window appears.

4. After the simulation begins processing data, start the AvnFPS menu. The AvnFPS
GUI launches after the AvnFPS decoders successfully start and after TAF data is
ingested into AvnFPS:

e.g. run start_avnfps in a separate terminal window.

5. Once the AvnFPS menu has loaded select Default and click the “TAFs” button to
load the AvnFPS monitor GUI.

Note: In this example there are 4 TAF sites being monitored: KABR, KATY,
KPIR, KMBG.

6. Load a TAF for KABR.

e.g. click the “KABR” button (which should be orange in color) on the AvhFPS
monitor

7. Editthe TAF.
e.g. click the “Text Editor” button
Make the following modifications to the TAF:

= On the first line, change the wind speed and direction from 16013KT to
20020KT

= Remove the entire second line
= On the third line, change the valid time from FM2200 to FM2300

= On the fourth line, change the wind speed and direction from 18015KT to
36030KT
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8. Send the TAF.
e.g. click the “Syntax” button on the top of the editor
e.g. click the “Send” button on the top of the editor
e.g. click “OK” in the transmit time GUI

e.g. close only the AvnFPS TAF editor window (not the monitor window)

9. Verify the edited TAF was sent and ingested into AvhFPS.
In the AvnFPS monitor window, check the following:
= The KABR button should no longer be orange in color

= The TAF time next to the KABR button should not be 2141. It should be a
time after 2200.

= Click on the “KABR” button and verify the TAF shows all the edits made in
step 7

10. After verifying the install was successful, shut down all AvnFPS windows, and exit
the simulator. You may consider putting icons on the desktop to run the
start_avnTps script. If you launch from an icon, you may need to select the run in
terminal option, so you can see the status while starting.

11.Verify your edited TAF was saved.

- To simulate the process of sending TAFs, WES writes the TAF to a text file in the
<data_case>/avnfps/archived_TAFs/previous_simulation directory

- After each simulation, WES copies the previous_simulation directory to a
<data_case>/saved_tafs/<date> directory, where <date> is the actual time
when the simulation ends:

e.g. cd /dataZawips/2006Aug24test/saved_tafs
e.g. Is (to look for the latest directory)

e.g. cd 200707042200 (for example, if you ran the simulation July 4, 2007 at
2200)

e.g. Is (to look at all the saved TAFs)

e.g. more ABRTAFABR (for example)
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Note: The latest TAF is always stored as CCCTAFXXX (e.g. ABRTAFABR).
The TAF used to initialize the simulation is always stored as CCCTAFXXX.init
(e.g. ABRTAFABR:.init). The long filenames in the saved_tafs directory are the
TAFs generated during the simulation (see Section 19.6).

Note: The TAF you just wrote will be used in the next section, so do not delete
this file.

5.8 Verify AvnFPS in Simulation Mode using Previous TAFs

In the last section we started by using a TAF supplied in the WES test case. In this
section, we will start a new simulation using the TAF you created in the previous
simulation. This functionality can be useful when running a sequence of simulations.

1. Runstart_simulator

2. Load the wes83 AvnFPS test _case ABR macro and then change the TAF entry
to use the TAF from the previous simulation.

e.g. click the “Run Simulation” button and the “OK” button in the D2D warning
popup

e.g. click the “Load Saved Settings” button, and select
“‘wes83 AvnFPS_test _case ABR?, then click the “OK” button in the Load window

e.g. click the “ Select” button next to the “Case Start Time” entry section and
change the minutes from 05 to 15 and then click “ OK”

e.g. click the “ Select” button next to the TAFs_Directory entry section and select
previous_simulation and then “OK”

e.g. click the “OK” button in the Simulation Entry window

Note: Selecting previous_simulation in the TAFs directory entry window
initializes the current simulation with the TAFs issued during the last simulation.

3. Click the “Run Simulation” button when the Entry Verification window appears.

4. After the simulation begins processing data, start the AvnFPS menu:

e.g. run start_avnfps

5. Once the AvnFPS menu had loaded, select Default and click the “TAFs” button
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6. Load the TAF for KABR:

e.g. click the “KABR” button on the AvnFPS monitor

7. Verify the initial TAF is the same as the latest TAF version in Section 5.7:
e.g. click the “Text Editor” button
Verify the following:
= On the first line, the wind speed and direction is 20020KT
= On the second line, the valid time is FM2300

= On the third line, the wind speed and direction is 36030KT

8. After verifying the TAF is the same, shut down D2D, all AvnFPS windows, and exit

the simulator.

5.9 Verification Completion

The next four sections cover customizing WES from a live AWIPS system.
The remainder of this document contains reference information including:
- Setting up cases
- The WES Scripting Language (WESSL)
- Using WES in a networked environment
- Manual installation of AWIPS freeware
- Manual installation of helper applications

- Configuration files
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